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About iPod shuffle

 

Congratulations on purchasing iPod shuffle. Read this 
chapter to learn about the features of iPod shuffle, how 
to use its controls, and more.

 

To use iPod shuffle, you put songs and other audio files on your computer and then 
sync them with iPod shuffle.

Use iPod shuffle to:
Â

 

Sync songs and playlists for listening on the go
Â

 

Listen to podcasts, downloadable radio-style shows, delivered over the Internet
Â

 

Listen to audiobooks purchased from the iTunes Store or audible.com
Â

 

Store or back up files and other data, using iPod shuffle as an external disk

 

What’s New in iPod shuffle
Â

 

Apple Earphones with Remote to control iPod shuffle easily while you’re on the go
Â

 

Support for multiple playlists and audiobooks
Â

 

New VoiceOver feature that announces the song and artist names, a menu of your 
playlists, audiobooks, and podcasts, and battery status and other messages

Â

 

Improved flexibility with syncing music and other content in iTunes

±

 

 

 

WARNING: 

 

 To avoid injury, read all operating instructions in this guide and 
the safety information in “Safety and Handling” on page 32 before using 
iPod shuffle. 
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iPod shuffle Basics

 

Read this chapter to learn about the features of 
iPod shuffle, how to use its controls, and more.

 

Your iPod shuffle package includes iPod shuffle, the Apple Earphones with Remote, and 
a USB 2.0 cable to connect iPod shuffle to your computer.

 

iPod shuffle at a Glance

Clip (in back)

Volume up

Center button 

Volume down

Earphone port

Status light

Three-way switch
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To use the Apple Earphones with Remote:
m

 

Plug the earphones into the earphone port on iPod shuffle. Then place the earbuds 
in your ears as shown. Use the buttons on the remote to control playback. 

You can purchase other accessories, such as the Apple In-Ear Earphones with Remote 
and Mic, and the Apple Earphones with Remote and Mic, at 
www.apple.com/ipodstore. The microphone capability isn’t supported on iPod shuffle.

 

Using the iPod shuffle Controls

 

The simple three-way switch (OFF, play in order ⁄

 

, or shuffle ¡

 

) on iPod shuffle and 
the buttons on the earphone remote make it easy to play songs, audiobooks, and 
audio podcasts on iPod shuffle, as described below.

 

WARNING:  

 

Read all safety instructions about avoiding hearing damage on page 33 
before use.

The earphone
cord is adjustable.

Remote

 

To Do this on iPod shuffle

 

Turn iPod shuffle on or off

 

Slide the three-way switch (green shading on switch indicates 
iPod shuffle is on).

 

Set the play order

 

Slide the three-way switch to play in order (⁄

 

) or shuffle (¡

 

).

 

Reset iPod shuffle

 

(if iPod shuffle isn’t responding or 
the status light is solid red)

Disconnect iPod shuffle from the computer. Turn iPod shuffle off, 
wait 10 seconds, and then turn it back on again.

 

Find the iPod shuffle serial 
number

 

Look under the clip on iPod shuffle. Or, in iTunes (with 
iPod shuffle connected to your computer), select iPod shuffle 
under Devices in iTunes and click the Summary tab.
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Connecting and Disconnecting iPod shuffle

 

Connect iPod shuffle to your computer to sync songs and other audio files, and to 
charge the battery. Disconnect iPod shuffle when you’re done.

 

Important:  

 

Use only the USB 2.0 cable that came with iPod shuffle to connect it to your 
computer.

 

Connecting iPod shuffle

 

To connect iPod shuffle to your computer:
m

 

Plug one end of the included USB cable into the earphone port of iPod shuffle, and the 
other end into a USB 2.0 port on your computer.

 

Note:  

 

Charging or syncing iPod shuffle is faster if you connect it to a high-power USB 
2.0 port. On most keyboards, the USB port doesn’t provide enough power to charge at 
optimal speed.

A longer USB cable is available separately at www.apple.com/ipodstore.

 

To Do this with the earphone remote

 

Play or pause

 

Click the Center button. 

 

Change the volume

 

Click the Volume Up (∂

 

) or Volume Down (D

 

) button. Click and 
hold to quickly increase or decrease volume.

 

Go to the next track

 

Double-click the Center button.

 

Fast-forward

 

Double-click and hold the Center button.

 

Go to the previous track

 

Triple-click the Center button within 6 seconds of the track 
starting. Triple-clicking after 6 seconds restarts the current track.

 

Rewind

 

Triple-click and hold the Center button. 

 

Hear song titles, artist names, 
and playlist names

 

To hear the current song title and artist name, click and hold the 
Center button. To listen to your playlist names, keep holding, and 
release when you hear a tone; then click to select the playlist you 
want. For more information, see “Using the VoiceOver Feature” on 
page 22.



 

Chapter 2   

 

 iPod shuffle Basics

 

7

 

 

The first time you connect iPod shuffle to your computer, iTunes helps you configure 
iPod shuffle and sync it with your iTunes library. By default, iTunes automatically syncs 
songs on iPod shuffle when you connect it to your computer. When iTunes is finished, 
you can disconnect iPod shuffle. You can sync songs while your battery is charging.

If you connect iPod shuffle to a different computer and iPod shuffle is set to sync music 
automatically, iTunes prompts you before syncing any music. If you click Yes, the songs 
and other audio files already on iPod shuffle will be erased and replaced with songs 
and other audio files on the computer iPod shuffle is connected to. For information 
about adding music to iPod shuffle and using iPod shuffle with more than one 
computer, see Chapter 4, “Listening to Music,” on page 20.

 

Disconnecting iPod shuffle

 

It’s important not to disconnect iPod shuffle from your computer while audio files are 
syncing or when iPod shuffle is being used as an external disk. It’s OK to disconnect 
iPod shuffle if the status light is not blinking orange, or if you see the “OK to 
disconnect” message at the top of the iTunes window. 

 

Important:  

 

If you see the “Do not disconnect” message in iTunes or if the status light 
on iPod shuffle is blinking orange, you must first eject iPod shuffle before 
disconnecting it. Failing to do so may damage files on iPod shuffle and require you to 
restore iPod shuffle in iTunes. For information about restoring, see “Updating and 
Restoring iPod shuffle Software” on page 31.

If you enable iPod shuffle for disk use (see page 26), you must always eject iPod shuffle 
before disconnecting it.

 

To eject iPod shuffle:
m

 

Click the Eject (C

 

) button next to iPod shuffle in the list of devices in iTunes.

 

If you’re using a Mac,

 

 you can also eject iPod shuffle by dragging the iPod shuffle icon 
on the desktop to the Trash.

 

If you’re using a Windows PC,

 

 you can also eject iPod shuffle in My Computer or by 
clicking the Safely Remove Hardware icon in the Windows system tray and selecting 
iPod shuffle.

 

To disconnect iPod shuffle:
m

 

Detach the USB cable from iPod shuffle and from the computer.
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Charging the Battery

 

iPod shuffle has an internal battery that is rechargeable and not user-replaceable. For 
best results, the first time you use iPod shuffle, let it charge for about three hours to 
fully charge it. The battery is 80-percent charged in about two hours and fully charged 
in about three hours. If iPod shuffle isn’t used for a while, the battery might need to be 
recharged. 

You can sync music while the battery is charging. You can disconnect and use 
iPod shuffle before it’s fully charged. 

In iTunes, the battery icon next to your iPod shuffle name shows the battery status. The 
icon displays a lightning bolt when the battery is charging and a plug when the battery 
is fully charged.

You can charge the iPod shuffle battery in two ways:
Â

 

Connect iPod shuffle to your computer.
Â

 

Use the Apple USB Power Adapter, available separately.

 

To charge the battery using your computer:
m

 

Connect iPod shuffle to a high-power USB 2.0 port on your computer using the 
included USB cable. The computer must be turned on and not in sleep mode. 

When the battery is charging, the status light on iPod shuffle is solid orange. When the 
battery is fully charged, the status light turns green. 

If iPod shuffle is being used as an external disk or is syncing with iTunes, the status light 
blinks orange to let you know that you must eject iPod shuffle before disconnecting it. 
In this case, your battery may be either still charging or fully charged. You can check 
the status by viewing the battery icon next to your iPod shuffle name in the list of 
devices in iTunes.

If you don’t see the status light, iPod shuffle might not be connected to a high-power 
USB 2.0 port. Try another USB 2.0 port on your computer. 

If you want to charge the battery when you’re away from your computer, you can 
connect iPod shuffle to an Apple USB Power Adapter. To purchase iPod shuffle 
accessories, go to www.apple.com/ipodstore.

 

To charge the battery using the Apple USB Power Adapter:
1

 

Connect the AC plug adapter to the power adapter (they might already be connected).

 

2

 

Plug the USB connector of the USB cable into the power adapter. 

 

3

 

Connect the other end of the USB cable to iPod shuffle.
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4

 

Plug the power adapter into a working power outlet. 

Rechargeable batteries have a limited number of charge cycles. Battery life 
and number of charge cycles vary by use and settings. For information, go to 
www.apple.com/batteries.

 

Checking the Battery Status

 

You can check the battery status of iPod shuffle when it’s connected to your computer 
or disconnected. The status light tells you approximately how much charge is in the 
battery. 

If iPod shuffle is on and not connected to a computer, check the battery status without 
interrupting playback by quickly turning iPod shuffle off and then on again. You can 
also use VoiceOver to hear battery status information.

 

WARNING:  

 

Make sure the power adapter is fully assembled before plugging it into a 
power outlet. Read all safety instructions about using the Apple USB Power Adapter 
on page 33 before use.

Apple USB Power Adapter
(your adapter may look different)

iPod shuffle USB cable

 

Status light when connected

 

 Solid green Fully charged

 Solid orange Charging

    
Blinking orange

Do not disconnect (iTunes is syncing, or iPod shuffle is enabled for 
disk use); may be still charging or may be fully charged

 

Status light when disconnected VoiceOver

 

 Solid green Good charge “Battery full”
“Battery 75%”
“Battery 50%”

 Solid orange Low charge “Battery 25%”

 Solid red Very low charge “Battery low”
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Setting Up iPod shuffle

 

To set up iPod shuffle, you use iTunes on your computer 
to import, buy, and organize your music, audio podcasts, 
and audiobooks. Then you connect iPod shuffle to your 
computer and sync it to your iTunes library.

Read on to learn more about the steps in this process, including:
Â Getting music from your CD collection, hard disk, or the iTunes Store (part of iTunes 

and available in some countries only) into the iTunes application on your computer
Â Organizing your music and other audio into playlists
Â Syncing songs, audiobooks, and podcasts (free downloadable radio-style shows) in 

your iTunes library with iPod shuffle
Â Listening to music or other audio on the go

About iTunes
iTunes is the software application you use to sync music, audiobooks, and audio 
podcasts with iPod shuffle. To download iTunes version 8.1 or later (required for 
iPod shuffle), go to www.apple.com/ipod/start. After you install iTunes, it opens 
automatically when you connect iPod shuffle to your computer.

This chapter explains how to use iTunes to download songs and other audio to your 
computer, create personal compilations of your favorite songs (called playlists), sync 
iPod shuffle, and adjust iPod shuffle settings.

iTunes also has a feature called Genius, which creates instant playlists of songs from 
your iTunes library that go great together. You can create Genius playlists in iTunes and 
sync them to iPod shuffle. To learn how to set up Genius in iTunes, see “Using Genius in 
iTunes” on page 14.

iTunes has many other features. You can burn your own CDs that play in standard CD 
players (if your computer has a recordable CD drive); listen to streaming Internet radio; 
watch videos and TV shows; rate songs according to preference; and much more. For 
information about using these features, open iTunes and choose Help > iTunes Help.
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If you already have iTunes installed on your computer and you’ve set up your iTunes 
library, you can skip to the next section, “Adding Music to iPod shuffle” on page 15.

Importing Music into Your iTunes Library
To listen to music on iPod shuffle, you first need to get that music into your iTunes 
library on your computer.

There are three ways to get music and other audio into your iTunes library:
Â Purchase music and audiobooks or download podcasts online from the iTunes Store.
Â Import music and other audio from audio CDs.
Â Add music and other audio that’s already on your computer.

Buying Songs and Downloading Podcasts Using the iTunes Store
If you have an Internet connection, you can easily purchase and download songs, 
albums, and audiobooks online using the iTunes Store. You can also subscribe to and 
download free radio-style audio podcasts. Video podcasts can’t be synced to 
iPod shuffle.

To purchase music online using the iTunes Store, you set up an Apple account in 
iTunes, find the songs you want, and then buy them. If you already have an Apple 
account, or if you have an America Online (AOL) account (available in some countries 
only), you can use that account to sign in to the iTunes Store and buy songs.

You don’t need an iTunes Store account to download or subscribe to podcasts.

To sign in to the iTunes Store:
m Open iTunes and then:

Â If you already have an iTunes account, choose Store > Sign In, and then sign in.
Â If you don’t already have an iTunes account, choose Store > Create Account and follow 

the onscreen instructions to set up an Apple account or enter your existing Apple or 
AOL account information.
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You can browse or search the iTunes Store to find the album, song, or artist you’re 
looking for. Open iTunes and click iTunes Store in the list on the left.
Â To browse the iTunes Store, choose a category (for example, Music) on the left side of 

the iTunes Store home page. You can choose a genre, look at new releases, click one 
of the featured songs, look at Top Songs and more, or click Browse under Quick Links 
in the main iTunes Store window.

Â To browse for podcasts, click the Podcasts link on the left side of the iTunes Store 
home page.

Â To search the iTunes Store, type the name of an album, song, artist, or composer in the 
search field. Press Return or choose an item from the list that appears.

Â To narrow your search results, choose an item from the pop-up menu in the upper left 
(the default is All Results). For example, to narrow your search to songs and albums, 
choose Music from the pop-up menu.

Â To search for a combination of items, click Power Search in the Search Results page.
Â To return to the home page of the iTunes Store, click the Home button in the status line 

at the top of the page.

To buy a song, album, or audiobook:
1 Select iTunes Store, and then find the item you want to buy.

You can double-click a song or other item to listen to a portion of it and make sure it’s 
what you want. (If your network connection is slower than 128 kbps, choose iTunes 
Preferences, and in the Store pane, select “Load complete preview before playing.”)

2 Click Buy Song, Buy Album, or Buy Book.

The item is downloaded to your computer and charged to the credit card listed in your 
Apple or AOL account.

To download or subscribe to a podcast:
1 Select iTunes Store.

2 Click the Podcasts link on the left side of the home page in the iTunes Store.

3 Browse for the podcast you want to download.

Â To download a single podcast episode, click the Get Episode button next to the 
episode.

Â To subscribe to a podcast, click the Subscribe button next to the podcast graphic. 
iTunes downloads the most recent episode. As new episodes become available, 
they’re automatically downloaded to iTunes when you connect to the Internet.

Adding Songs Already on Your Computer to Your iTunes Library
If you have songs on your computer encoded in file formats that iTunes supports, you 
can easily add the songs to iTunes.
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To add songs on your computer to your iTunes library:
m Drag the folder or disk containing the audio files to your iTunes library (or choose File > 

Add to Library and select the folder or disk). If iTunes supports the song file format, the 
songs are automatically added to your iTunes library.

You can also drag individual song files to iTunes. 

Note:  Using iTunes for Windows, you can convert nonprotected WMA files to AAC or 
MP3 format. This can be useful if you have a library of music encoded in WMA format. 
For more information, open iTunes and choose Help > iTunes Help.

Importing Music from Your Audio CDs into iTunes
Follow these instructions to get music from your CDs into iTunes.

To import music from an audio CD into iTunes:
1 Insert a CD into your computer and open iTunes. 

If you have an Internet connection, iTunes gets the names of the songs on the CD from 
the Internet (if available) and lists them in the window.

If you don’t have an Internet connection, you can import your CDs, and later, when you’re 
connected to the Internet, select the songs in iTunes and then choose Advanced > Get 
CD Track Names. iTunes will bring in the track names for the imported CDs. 

If the CD track names aren’t available online, you can enter the names of the songs 
manually. See the following section, “Entering Names of Songs and Other Details.”

With song information entered, you can browse for songs in iTunes by title, artist, 
album, and more. 

2 Click to remove the checkmark next to any song you don’t want to import.

3 Click the Import button. The display area at the top of the iTunes page shows how long 
it will take to import each song.

By default, iTunes plays songs as they’re imported. If you’re importing a lot of songs, 
you might want to stop the songs from playing to improve performance.

4 To eject the CD, click the Eject (C) button.

You can’t eject a CD until the import is done.

5 Repeat these steps for any other CDs with songs you want to import.

Entering Names of Songs and Other Details
You can manually enter song titles and other information, including comments, for 
songs and other items in your iTunes library.

To enter CD song names and other information manually:
1 Select the first song on the CD and choose File > Get Info.

2 Click Info.
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3 Enter the song information.

4 Click Next to enter information for the next track.

5 Click OK when you finish.

Organizing Your Music
Using iTunes, you can organize songs and other items into lists, called playlists, in any 
way you want. For example, you can create playlists with songs to listen to while 
exercising, or playlists with songs for a particular mood. 

You can also create Smart Playlists that update automatically based on rules you define. 
When you add songs to iTunes that match the rules, they get added automatically to 
the Smart Playlist. You can also pick a song and use the Genius feature to create a 
playlist for you (see the next section for more information). You can’t create a playlist on 
iPod shuffle when it’s disconnected from iTunes.

You can create as many playlists as you like, using any of the songs in your iTunes 
library. Changes you make to any of your playlists in iTunes, such as adding or 
removing songs, won’t change the contents of your iTunes library. 

When you listen to playlists on iPod shuffle, all playlists created in iTunes behave the 
same way. You can choose them by name on your iPod shuffle. 

To create a playlist in iTunes:
1 Click the Add (∂) button or choose File > New Playlist.

2 Type a name for the playlist. 

3 Click Music in the Library list, and then drag a song or other item to the playlist. 

To select multiple songs, hold down the Shift key or the Command (x) key on a Mac, 
or the Shift key or the Control key on a Windows PC, as you click each song.

To create a Smart Playlist:
m Choose File > New Smart Playlist and define the rules for your playlist.

Smart playlists created in iTunes can be synced to iPod shuffle like any other iTunes 
playlist.

Using Genius in iTunes
Genius automatically creates playlists containing songs in your library that go great 
together. To play Genius playlists on iPod shuffle, you first need to set up Genius in 
iTunes. Genius is a free service, but you need an iTunes Store account (if you don’t have 
one, you can set one up when you turn on Genius).

To set up Genius:
1 In iTunes, choose Store > Turn on Genius.



Chapter 3    Setting Up iPod shuffle 15

 

2 Follow the onscreen instructions.

3 Connect and sync iPod shuffle.

You can now use Genius to create a Genius playlist that you can sync to iPod shuffle.

To create a Genius playlist in iTunes:
1 Click Music in the Library list or select a playlist.

2 Select a song.

3 Click the Genius button at the bottom of the iTunes window.

4 To change the maximum number of songs included in the playlist, choose a number 
from the pop-up menu.

5 To save the playlist, click Save Playlist. You can change a saved playlist by adding or 
removing items. You can also click Refresh to create a new playlist based on the same 
original song.

Genius playlists created in iTunes can be synced to iPod shuffle like any other iTunes 
playlist.

Adding Music to iPod shuffle
After your music is imported and organized in iTunes, you can easily add it to 
iPod shuffle.

To set how music is added from iTunes on your computer to iPod shuffle, you connect 
iPod shuffle to your computer, and then use iTunes preferences to choose iPod shuffle 
settings.

You can set iTunes to add music to iPod shuffle in three ways:
Â Sync songs and playlists:  When you connect iPod shuffle, it’s automatically updated to 

match the songs and other items in your iTunes library. You can sync all songs and 
playlists or selected playlists. Any other songs on iPod shuffle are deleted. See the 
following section for more information.
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Â Manually add music to iPod shuffle:  When you connect iPod shuffle, you can drag 
songs and playlists individually to iPod shuffle, and delete songs and playlists 
individually from iPod shuffle. Using this option, you can add songs from more than 
one computer without erasing songs from iPod shuffle. When you manage music 
yourself, you must always eject iPod shuffle from iTunes before you can disconnect it. 
See “Managing iPod shuffle Manually” on page 17.

Â Autofill iPod shuffle:  When you choose to manually manage content on iPod shuffle, 
you can have iTunes automatically fill iPod shuffle with a selection of songs and other 
content that you specify. See “Autofilling iPod shuffle” on page 18.

Syncing Music Automatically
By default, iPod shuffle is set to sync all songs and playlists when you connect it to your 
computer. This is the simplest way to add music to iPod shuffle. You just connect 
iPod shuffle to your computer, let it add songs, audiobooks, and audio podcasts 
automatically, and then disconnect it and go. If you added any songs to iTunes since 
the last time you connected iPod shuffle, they’re synced with iPod shuffle. If you 
deleted songs from iTunes, they’re removed from iPod shuffle.

To sync music with iPod shuffle:
m Simply connect iPod shuffle to your computer. If iPod shuffle is set to sync 

automatically, the update begins.

Important:  The first time you connect iPod shuffle to a computer, a message asks if you 
want to sync songs automatically. If you accept, all songs, audiobooks, and podcasts 
are erased from iPod shuffle and replaced with songs and other items from that 
computer. If you don’t accept, you can still add songs to iPod shuffle manually without 
erasing any of the songs already on iPod shuffle.

While music is being synced from your computer to iPod shuffle, the iTunes status 
window shows progress, and you see a sync icon next to iPod shuffle in the list of 
devices. When the update is done, a message in iTunes says “iPod update is complete.”

If, during iPod shuffle setup, you didn’t choose to automatically sync music to 
iPod shuffle, you can do it later. You can sync all songs and playlists, or just selected 
playlists.

To set up iTunes to automatically sync music with iPod shuffle:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices, and then click the Music tab.

3 Select “Sync music.”

4 Choose “All songs and playlists,” or choose “Selected playlists” and then select the 
playlists you want to sync.
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You can sync audiobooks when you sync music. Audiobooks appear in the list of 
selected playlists. You can choose to sync all or none of the audiobooks in your iTunes 
library.

5 Click Apply.

The update begins automatically.

If “Sync only checked songs” is selected in the Summary pane, iTunes syncs only items 
that are checked in your Music and other libraries.

Syncing Podcasts Automatically
The settings for adding podcasts to iPod shuffle are unrelated to the settings for 
adding songs. Podcast settings don’t affect song settings, and vice versa. You can set 
iTunes to automatically sync all podcasts or selected podcasts, or you can add podcasts 
to iPod shuffle manually. You can’t sync video podcasts to iPod shuffle.

To set iTunes to update the podcasts on iPod shuffle automatically:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices, and then click the Podcasts tab.

3 Select “Sync ... episodes of” and choose the number of episodes you want from the 
pop-up menu.

4 Select “All podcasts,” or “Selected podcasts.” If you click “Selected podcasts,” also select 
the podcasts that you want to sync.

5 Click Apply.

When you set iTunes to sync podcasts automatically, iPod shuffle is updated each time 
you connect it to your computer.

Managing iPod shuffle Manually
Setting iTunes to let you manage iPod shuffle manually gives you the most flexibility 
for managing music and other content on iPod shuffle. You can add and remove 
individual songs, playlists, podcasts, and audiobooks. You can add music and other 
audio content from multiple computers to iPod shuffle without erasing items already 
on iPod shuffle.

To set iTunes to let you manage audio content on iPod shuffle manually:
1 In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab. 

2 In the Options section, select “Manually manage music.”

3 Click Apply.

When you manage iPod shuffle manually, you must always eject iPod shuffle from 
iTunes before you disconnect it.

To add a song or other item to iPod shuffle:
1 Click Music or another Library item in iTunes.
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2 Drag a song or other item to iPod shuffle.

You can also drag entire playlists to sync them with iPod shuffle. You can select 
multiple items and drag them all at once to iPod shuffle.

To remove a song or other item from iPod shuffle:
1 In iTunes, select iPod shuffle in the list of devices.

2 Select Music, Audiobooks, or Podcasts under iPod shuffle.

3 Select a song or other item and press the Delete or Backspace key on your keyboard. 

To use iTunes to create a new playlist on iPod shuffle:
1 In iTunes, select iPod shuffle in the list of devices, and then click the Add (∂) button or 

choose File > New Playlist.

2 Type a name for the playlist.

3 Click an item, such as Music, in the Library list, and then drag songs or other items to 
the playlist.

To add songs to or remove songs from a playlist on iPod shuffle:
m Drag a song to a playlist on iPod shuffle to add the song. Select a song in a playlist and 

press the Delete key on your keyboard to delete the song.

Keep these points in mind if you manually manage your content on iPod shuffle:

Â If you make changes to any of your playlists, remember to drag the changed playlist 
to iPod shuffle when it’s connected to iTunes.

Â If you remove a song or other item from iPod shuffle, it isn’t deleted from your iTunes 
library. 

Â If you set iTunes to manage music manually, you can reset it later to sync 
automatically. For information, see page 16.

Autofilling iPod shuffle
If you manually manage music, you can have iTunes automatically sync a selection of 
your songs onto iPod shuffle when you click the Autofill button. You can choose your 
entire library or a specific playlist to gets songs from, and set other Autofill options. 
Using Autofill gives you more control over the content that gets added to iPod shuffle 
than automatically syncing, and lets you quickly “top off” your iPod shuffle when you 
manually manage the contents.

To autofill music onto iPod shuffle:
1 Connect iPod shuffle to your computer. 

2 Select Music under iPod shuffle in the list of devices.

3 Choose the playlist you want to autofill from using the “Autofill from” pop-up menu.

To autofill music from your entire library, choose Music.
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4 Click the Settings button to select from the following options:

Replace all items when Autofilling:  iTunes replaces the songs on iPod shuffle with the 
new songs you’ve chosen. If this option isn’t selected, songs you’ve already synced with 
iPod shuffle remain and iTunes selects more songs to fill the available space.

Choose items randomly:  iTunes shuffles the order of songs as it syncs them with 
iPod shuffle. If this option isn’t selected, iTunes downloads songs in the order they 
appear in your library or selected playlist.

Choose higher rated items more often:  iTunes autofills iPod shuffle, giving preference to 
songs that you’ve rated with a higher number of stars.

5 To reserve space for disk use, adjust the slider to set how much space to reserve for 
iTunes content and how much for data.

For more information about using iPod shuffle as a hard disk, see “Using iPod shuffle as 
an External Disk” on page 26.

6 Click OK in the Autofill Settings dialog, and then click Autofill in the iTunes window.

While music is being synced from iTunes to iPod shuffle, the iTunes status window 
shows the progress. When the autofill is done, a message in iTunes says “iPod update is 
complete.”

Fitting More Songs onto iPod shuffle
If you’ve imported songs into iTunes at higher bit-rate formats, such as iTunes Plus, 
Apple Lossless, or WAV, you can set iTunes to automatically convert songs to 128 kbps 
AAC files as they’re synced with iPod shuffle. This doesn’t affect the quality or size of 
the songs in iTunes.

Note:  Songs in formats not supported by iPod shuffle must be converted if you want to 
sync them with iPod shuffle. For more information about formats supported by 
iPod shuffle, see “If you can’t sync a song or other item onto iPod shuffle” on page 29.

To convert higher bit-rate songs to AAC files:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices.

3 Click the Summary tab.

4 Select “Convert higher bit rate songs to 128 kbps AAC.”

5 Click Apply.
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4 Listening to Music

After you set up iPod shuffle, you can listen to songs, 
audiobooks, and podcasts. Read this chapter to learn 
about listening to iPod shuffle on the go.

When you disconnect iPod shuffle from your computer, you can clip on iPod shuffle 
and listen to music, audiobooks, and podcasts, while controlling playback with the 
earphone remote. VoiceOver lets you hear the name of the song you’re playing, choose 
from a spoken menu of playlists, or get battery status. 

Playing Music
After you sync iPod shuffle with music and other audio content, you can listen to it. 

To listen to songs and other items on iPod shuffle:
1 Plug the earphones into iPod shuffle and place the earbuds in your ears.

2 Slide the three-way switch on iPod shuffle from OFF to play in order (⁄) or 
shuffle (¡).

Playback begins. If iPod shuffle is on when you plug in earphones, playback doesn’t 
start automatically. Click the Center button on the remote or slide the three-way 
switch off and on again to start playback.

To preserve battery life when you aren’t using iPod shuffle, slide the three-way 
switch to OFF.

When you plug in earphones, wait until the green status light turns off before 
clicking buttons on the remote. Refer to the table that follows for information about 
controlling playback with the earphone remote. 

WARNING:  Read all safety instructions about avoiding hearing damage on page 33 
before use.
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The status light on iPod shuffle blinks in response when you click the buttons on the 
earphone remote.

Setting iPod shuffle to Play Songs in Order or Shuffle Songs
You can set iPod shuffle to shuffle songs or play them in the order in which they’re 
organized in iTunes. You hear a tone when you slide the three-way switch.

To set iPod shuffle to play songs in order:
m Slide the three-way switch to play in order (⁄).

After the last song plays, iPod shuffle starts playing the first song again.

Important:  When you listen to audiobooks or podcasts, slide the three-way switch to 
play in order so chapters or episodes play in the recorded order.

To set iPod shuffle to shuffle: 
m Slide the three-way switch to shuffle (¡).

To Do this Status light response

Play Click the Center button once.  Blinks green once

Pause Click the Center button once.     Blinks green for 
30 seconds

Change the volume Click the Volume Up (∂) or Volume 
Down (D) button to increase or decrease 
the volume. Click and hold to change the 
volume quickly. You hear a tone when 
you change the volume while 
iPod shuffle is paused.

 Blinks green for each 
volume increment

   Blinks orange three 
times when the upper or lower 
volume limit is reached

Go to the next track (or 
audiobook chapter)

Double-click the Center button.  Blinks green once

Go to the previous track 
(or audiobook chapter)

Triple-click the Center button within 6 
seconds of the track starting. To restart 
the current track, triple-click after 6 
seconds.

 Blinks green once

Fast-forward Double-click and hold the Center button.  Blinks green once

Rewind Triple-click and hold the Center button.  Blinks green once

Hear song title and artist 
names

Click and hold the Center button.  Blinks green once

Hear playlist menu Click the Center button until you hear a 
tone, and then release to hear the 
playlist menu. When you hear the name 
of the playlist you want, click to select it. 
You can click ∂ or D to move quickly 
through the playlist menu.

 Blinks green once

Exit the playlist menu Click and hold the Center button.  Blinks green once
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To reshuffle songs, slide the three-way switch from shuffle (¡) to play in order (⁄) 
and back to shuffle again.

Using the VoiceOver Feature
iPod shuffle can provide more control over your playback options by speaking your 
song titles and artist names, and announcing a menu of playlists for you to choose 
from. VoiceOver also tells you battery status and other messages. VoiceOver is available 
in selected languages.

To hear these announcements, install the VoiceOver Kit and enable the VoiceOver 
feature in iTunes. You can enable VoiceOver when you first set up iPod shuffle, or you 
can do it later.

You set VoiceOver options on the Summary tab in iTunes. The following sections 
describe how to turn on and customize this feature. 

To enable VoiceOver when you set up iPod shuffle:
1 Connect iPod shuffle to your computer.

2 Follow the onscreen instructions in iTunes. Enable VoiceOver is selected by default.

3 Click Continue, and then follow the onscreen instructions to download and install the 
VoiceOver Kit. 

4 In the Summary tab, under Voice Feedback, choose the language you want from the 
Language pop-up menu.

This sets the language for your spoken system messages and playlist names, as well as 
many of the song titles and artist names. 

Note:  To pick a different language for specific songs, select them in iTunes, choose 
File > Get Info, choose a VoiceOver language from the pop-up menu on the Options 
tab, and then click OK.

5 Click Apply.

When setup is complete, VoiceOver is enabled on iPod shuffle.

To enable VoiceOver at a later time:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices, and click the Summary tab.

3 Under Voice Feedback, select Enable VoiceOver. 

4 Click Apply.

5 Follow the onscreen instructions to download and install the VoiceOver Kit.

6 Choose the language you want from the pop-up menu under Voice Feedback.

7 Click Apply.
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When syncing is finished, VoiceOver is enabled.

To disable VoiceOver:
1 In iTunes, select iPod shuffle in the list of devices, and click the Summary tab.

2 Under Voice Feedback, click to deselect Enable VoiceOver.

3 Click Apply.

When syncing is finished, VoiceOver is disabled. You’ll still hear some system 
announcements in English on iPod shuffle, such as battery status, error messages, and a 
generic numbered playlist menu. You won’t hear song titles and artist names.

Hearing Song Announcements
The VoiceOver feature can speak the current song title and artist name while you’re 
listening to iPod shuffle. If you don’t want to hear song titles and artist names, you can 
disable VoiceOver in iTunes (see “Using the VoiceOver Feature” on page 22).

To hear the current song announcement:
m Click and hold the Center button on the remote. 

You hear the current song title and artist name. If you’re listening to an audiobook, you 
hear the book title.

You can use VoiceOver to navigate to another song when you’re listening to song 
announcements.

To navigate using song announcements:
Â If iPod shuffle is playing, click and hold the Center button to hear the current song 

announcement; double-click to hear the next announcement while the next song 
plays; triple-click to hear the previous announcement while the previous song plays.

Â If iPod shuffle is paused, click and hold the Center button to hear the current song 
announcement; double-click to hear the next announcement; triple-click to hear the 
previous announcement. Press the Center button to play the announced song.

Using the Playlist Menu
When VoiceOver is enabled, you can choose from a spoken menu to listen to any 
playlist you’ve synced from iTunes to iPod shuffle. If audiobooks and audio podcasts are 
synced to iPod shuffle, their titles are also read as part of the playlist menu. If VoiceOver 
is disabled in iTunes, you hear an abbreviated menu of playlists in numbered order, but 
not by name (for example, “Playlist 1, Playlist 2,” and so on).
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The playlist menu announces items in this order: 

Â The current playlist (if applicable)
Â “All Songs” (default playlist of all the songs on iPod shuffle)
Â Any remaining playlists in order
Â “Podcasts” (if you choose this, you go to the first podcast in your list; you can 

navigate from there to other podcasts)
Â Audiobooks (each audiobook title is a separate playlist announcement)

To choose an item from the playlist menu:
1 Click and hold the Center button on the remote.

2 Continue holding after you hear the current song announcement, until you hear a tone.

3 Release the Center button at the tone. You hear the names of your playlists.

When you’re listening to the playlist menu, you can click the Volume Up (∂) or Volume 
Down (D) button to move forward or backward in the playlist menu.

4 When you hear the name of the playlist you want, click the Center button to select it. 
You hear a tone, and then the first item in your playlist plays.

To restart a playlist, follow these steps to select the playlist you want.

To exit from the playlist menu:
m Click and hold the Center button on the remote.

Setting Songs to Play at the Same Volume Level
The loudness of songs and other audio may vary depending on how the audio was 
recorded or encoded. You can set iTunes to automatically adjust the volume of songs 
so they play at the same relative volume level, and you can set iPod shuffle to use 
those same iTunes volume settings.

To set iTunes to play songs at the same volume level:
1 In iTunes, choose iTunes > Preferences if you’re using a Mac, or choose Edit > 

Preferences if you’re using a Windows PC.

2 Click Playback and select Sound Check.

To set iPod shuffle to use the iTunes volume settings:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices.

3 Click the Summary tab.

4 Select Enable Sound Check.

5 Click Apply.

If you haven’t turned on Sound Check in iTunes, setting it on iPod shuffle has no effect.
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Setting a Volume Limit
You can set a limit for the volume on iPod shuffle. You can also set a password in iTunes 
to prevent anyone else from changing this setting.

If you’ve set a volume limit on iPod shuffle, the status light blinks orange three times if 
you try to increase the volume beyond the limit.

To set a volume limit for iPod shuffle:
1 Set iPod shuffle to the desired maximum volume.

2 Connect iPod shuffle to your computer.

3 In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.

4 Select “Limit maximum volume.”

5 Drag the slider to the desired maximum volume.

The initial slider setting shows the volume iPod shuffle was set to when you selected 
the “Limit maximum volume” checkbox.

6 To require a password to change this setting, click the lock and then enter and verify a 
password.

If you set a password, you must enter it before you can change or remove the volume 
limit. 

Note:  The volume level may vary if you use different earphones or headphones.

To remove the volume limit:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices.

3 Click the Summary tab.

4 Deselect “Limit maximum volume.”

Enter the password, if required.

If you forget the password, you can restore iPod shuffle. See “Updating and Restoring 
iPod shuffle Software” on page 31.
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5 Storing Files on iPod shuffle

Use iPod shuffle to carry your data as well as your music.

Read this chapter to find out how to use iPod shuffle as an external disk.

Using iPod shuffle as an External Disk
You can use iPod shuffle as an external disk to store data files. 

To sync iPod shuffle with music and other audio that you want to listen to, you must 
use iTunes. You can’t play audio files that you’ve copied to iPod shuffle using the 
Macintosh Finder or Windows Explorer.

To enable iPod shuffle as an external disk:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices.

3 Click the Summary tab.

4 In the Options section, select “Enable disk use.”

You may need to scroll down to see the disk settings.

5 Click Apply.

When you set iTunes to autofill iPod shuffle, you can reserve space for disk use. See 
“Autofilling iPod shuffle” on page 18.

When you use iPod shuffle as an external disk, the iPod shuffle disk icon appears on the 
desktop on a Mac, or as the next available drive letter in Windows Explorer on a 
Windows PC.

When iPod shuffle is enabled as a hard disk and you connect it to your computer, the 
status light blinks orange continuously. Be sure to eject iPod shuffle in iTunes before 
you disconnect it from your computer.
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Transferring Files Between Computers
When you enable disk use on iPod shuffle, you can transfer files from one computer to 
another. iPod shuffle is formatted as a FAT-32 volume, which is supported by both Macs 
and PCs. This allows you to use iPod shuffle to transfer files between computers with 
different operating systems. 

To transfer files between computers:
1 After enabling disk use on iPod shuffle, connect it to the computer you want to get the 

files from.

Important:  If iPod shuffle is set to sync automatically, when you connect iPod shuffle to 
a different computer or user account, a message asks if you want to erase iPod shuffle 
and sync with the new iTunes library. Click Cancel if you don’t want to erase what’s on 
iPod shuffle. 

2 Using the computer’s file system (the Finder on a Mac, Windows Explorer on a PC), drag 
the files to your iPod shuffle.

3 Disconnect iPod shuffle, and then connect it to the other computer.

Again, click Cancel if you don’t want to erase what’s on iPod shuffle.

4 Drag the files from iPod shuffle to a location on the other computer.

Preventing iTunes from Opening Automatically
You can keep iTunes from opening automatically when you connect iPod shuffle to 
your computer.

To prevent iTunes from opening automatically:
1 Connect iPod shuffle to your computer.

2 In iTunes, select iPod shuffle in the list of devices.

3 Click the Summary tab.

4 In the Options section, deselect “Open iTunes when this iPod is connected.”

5 Click Apply.
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6 Tips and Troubleshooting

Most problems with iPod shuffle can be solved quickly by 
following the advice in this chapter.

If the status light glows red persistently or you hear the error message “Please use 
iTunes to restore”
Connect iPod shuffle to your computer and restore it in iTunes. See “Updating and 
Restoring iPod shuffle Software” on page 31.

If iPod shuffle won’t turn on or respond
Â Connect iPod shuffle to a high-power USB 2.0 port on your computer. Your 

iPod shuffle battery may need to be recharged. 
Â Turn iPod shuffle off, wait 10 seconds, and then turn it on again.
Â You may need to restore iPod shuffle software. See “Updating and Restoring 

iPod shuffle Software” on page 31.

The 5 Rs: Reset, Retry, Restart, Reinstall, Restore
Remember these five basic suggestions if you have a problem with iPod shuffle. Try 
these steps one at a time until the problem is resolved. If one of the following doesn’t 
help, read on for solutions to specific problems. 
Â Reset iPod shuffle by turning it off, waiting 10 seconds, and then turning it back on 

again.
Â Retry with a different USB 2.0 port if you cannot see iPod shuffle in iTunes.
Â Restart your computer, and make sure you have the latest software updates 

installed.
Â Reinstall iTunes software from the latest version on the web.
Â Restore iPod shuffle. See “Updating and Restoring iPod shuffle Software” on 

page 31.
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If iPod shuffle isn’t playing music
Â iPod shuffle might not have any music on it. If you hear the message “Please use 

iTunes to sync music,” connect iPod shuffle to your computer to sync music to it.
Â Slide the three-way switch off and then on again.
Â Make sure the earphone or headphone connector is pushed in all the way. 
Â Make sure the volume is adjusted properly. A volume limit might be set. See “Setting 

a Volume Limit” on page 25.
Â iPod shuffle might be paused. Try clicking the Center button on the earphone 

remote. 

If you connect iPod shuffle to your computer and nothing happens
Â Connect iPod shuffle to a high-power USB 2.0 port on your computer. Your 

iPod shuffle battery may need to be recharged. 
Â Make sure you’ve installed the latest iTunes software from 

www.apple.com/ipod/start. 
Â Try connecting the USB cable to a different USB 2.0 port on your computer. Make 

sure the USB cable is firmly connected toiPod shuffle and to the computer. Make sure 
the USB connector is oriented correctly. It can be inserted only one way.

Â iPod shuffle might need to be reset. Turn iPod shuffle off, wait 10 seconds, and then 
turn it back on again.

Â If iPod shuffle doesn’t appear in iTunes or the Finder, the battery may be completely 
discharged. Let iPod shuffle charge for several minutes to see if it comes back to life.

Â Make sure you have the required computer and software. See “If you want to double-
check the system requirements” on page 30.

Â Try restarting your computer.
Â You might need to restore iPod software. See “Updating and Restoring iPod shuffle 

Software” on page 31.
Â iPod shuffle may need to be repaired. You can arrange for service on the iPod shuffle 

Service & Support website at www.apple.com/support/ipodshuffle/service.

If you can’t sync a song or other item onto iPod shuffle
The song might have been encoded in a format that iPod shuffle doesn’t support. The 
following audio file formats are supported by iPod shuffle. These include formats for 
audiobooks and podcasts:
Â AAC (M4A, M4B, M4P) (up to 320 kbps)
Â Apple Lossless (a high-quality compressed format)
Â MP3 (up to 320 kbps)
Â MP3 Variable Bit Rate (VBR)
Â WAV
Â AA (audible.com spoken word, formats 2, 3, and 4)
Â AIFF
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A song encoded using Apple Lossless format has near full CD-quality sound, but takes 
up only about half as much space as a song encoded using AIFF or WAV format. The 
same song encoded in AAC or MP3 format takes up even less space. When you import 
music from a CD using iTunes, it’s converted to AAC format by default.

You can have iPod shuffle automatically convert files encoded at higher bit rates to 128 
kbps AAC files as they’re synced with iPod shuffle. See “Fitting More Songs onto 
iPod shuffle” on page 19.

Using iTunes for Windows, you can convert unprotected WMA files to AAC or MP3 
format. This can be useful if you have a collection of music encoded in WMA format. 

iPod shuffle doesn’t support WMA, MPEG Layer 1, MPEG Layer 2 audio files, or 
audible.com format 1.

If you have a song in iTunes that isn’t supported by iPod shuffle, you can convert it to a 
format iPod shuffle supports. For more information, see iTunes Help.

If your podcasts or audiobooks don’t play correctly 
Â Make sure the three-way switch on iPod shuffle is set to play in order (⁄). If a 

playlist includes mixed tracks (songs, podcasts, and audiobooks, for example), 
audiobooks and podcasts won’t play if iPod shuffle is set to shuffle (¡).

Â If the chapters of an audiobook were added to iPod shuffle out of order, connect 
iPod shuffle to your computer and rearrange the tracks using iTunes.

If you want to double-check the system requirements
To use iPod shuffle, you must have:
Â One of the following computer configurations:

Â A Macintosh with a USB 2.0 port 
Â A Windows PC with a USB 2.0 port or a USB 2.0 card installed 

Â One of the following operating systems: Mac OS X v10.4.11 or later, Windows Vista, or 
Windows XP Home or Professional with Service Pack 3 or later

Â Internet access (a broadband connection is recommended)
Â iTunes 8.1 or later (iTunes can be downloaded from www.apple.com/ipod/start)

If your Windows PC doesn’t have a high-power USB 2.0 port, you can purchase and install 
a USB 2.0 card. 

High-power USB 2.0 port



Chapter 6    Tips and Troubleshooting 31

 

If you want to use iPod shuffle with a Mac and a Windows PC
If your iPod shuffle is set to manually manage music, you can add content to it from 
more than one iTunes library, regardless of the operating system on the computer. If 
your iPod shuffle is set to sync automatically, when you connect iPod shuffle to a 
different computer or user account, a message asks if you want to erase iPod shuffle 
and sync with the new iTunes library. Click Cancel if you want to keep the contents of 
iPod shuffle as is.

You can use iPod shuffle as an external disk with both Macintosh computers and PCs, 
allowing you to transfer files from one operating system to the other. See Chapter 5, 
“Storing Files on iPod shuffle,” on page 26.

Updating and Restoring iPod shuffle Software
You can use iTunes to update or restore the iPod shuffle software. It’s recommended 
that you update iPod shuffle to use the latest software. You can also restore the 
software, which returns iPod shuffle to its original state.
Â If you choose to update, the software is updated but your settings, songs, and other 

data aren’t affected. 
Â If you choose to restore, all data is erased from iPod shuffle, including songs and any 

other data. All iPod shuffle settings are restored to their original state.

To update or restore iPod shuffle:
1 Make sure you have an Internet connection and have installed the latest version of 

iTunes from www.apple.com/ipod/start.

2 Connect iPod shuffle to your computer.

3 In iTunes, select iPod shuffle in the list of devices, and click the Summary tab.

The Version section tells you whether iPod shuffle is up to date or needs a newer 
version of the software. 

4 Do one of the following:

Â To install the latest version of the software, click Update.
Â To restore iPod shuffle to its original settings, click Restore. This erases all data from 

iPod shuffle. Follow the onscreen instructions to complete the restore process.
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7 Safety and Handling

This chapter contains important safety and handling 
information for iPod shuffle.

Keep this user guide for your iPod shuffle handy for future reference.

Important Safety Information

Handling iPod shuffle  Do not drop, dissemble, open, crush, bend, deform, puncture, 
shred, microwave, incinerate, paint, or insert foreign objects into iPod shuffle. 

Avoiding water and wet locations  Do not use iPod shuffle in rain, or near washbasins 
or other wet locations. Take care not to spill any food or liquid on iPod shuffle. In case 
iPod shuffle gets wet, unplug all cables, turn off iPod shuffle (slide the three-way switch 
to OFF) before cleaning, and allow it to dry thoroughly before turning it on again. Do 
not attempt to dry iPod shuffle with an external heat source, such as a microwave oven 
or hair dryer.

Repairing iPod shuffle  Never attempt to repair or modify iPod shuffle yourself. 
iPod shuffle doesn’t contain any user-serviceable parts. If iPod shuffle has been 
submerged in water, punctured, or subjected to a severe fall, do not use it until you 
take it to an Apple Authorized Service Provider. For service information, choose iPod 
Help from the Help menu in iTunes or go to www.apple.com/support/ipod/service. The 
rechargeable battery in iPod shuffle should be replaced only by an Apple Authorized 
Service Provider. For more information about batteries, go to www.apple.com/batteries.

± Read all safety information below and operating instructions before using 
iPod shuffle to avoid injury. 

WARNING:  Failure to follow these safety instructions could result in fire, electric shock, 
or other injury or damage.
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Using the Apple USB Power Adapter (available separately)  If you use the Apple USB 
Power Adapter (sold separately at www.apple.com/ipodstore) to charge iPod shuffle, 
make sure that the power adapter is fully assembled before you plug it into a power 
outlet. Then insert the Apple USB Power Adapter firmly into the power outlet. Do not 
connect or disconnect the Apple USB Power Adapter with wet hands. Do not use any 
power adapter other than the Apple USB Power Adapter to charge your iPod shuffle.

The Apple USB Power Adapter may become warm during normal use. Always allow 
adequate ventilation around the Apple USB Power Adapter and use care when 
handling.

Unplug the Apple USB Power Adapter if any of the following conditions exist:
Â The power cord or plug has become frayed or damaged.
Â The adapter is exposed to rain, liquids, or excessive moisture.
Â The adapter case has become damaged.
Â You suspect the adapter needs service or repair.
Â You want to clean the adapter.

Avoiding hearing damage  Permanent hearing loss may occur if earbuds or 
headphones are used at high volume. Set the volume to a safe level. You can adapt 
over time to a higher volume of sound that may sound normal but can be damaging to 
your hearing. If you experience ringing in your ears or muffled speech, stop listening 
and have your hearing checked. The louder the volume, the less time is required before 
your hearing could be affected. Hearing experts suggest that to protect your hearing:

Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings.
Â Turn the volume down if you can’t hear people speaking near you.

For information about how to set a volume limit on iPod shuffle, see “Setting a Volume 
Limit” on page 25.

Driving safely  Use of iPod shuffle alone, or with earphones (even if used in only one 
ear) while operating a vehicle is not recommended and is illegal in some areas. Be 
careful and attentive while driving. Stop using iPod shuffle if you find it disruptive or 
distracting while operating any type of vehicle, or performing any other activity that 
requires your full attention.
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Important Handling Information

Carrying iPod shuffle  iPod shuffle contains sensitive components. Do not bend, drop, 
or crush iPod shuffle.

Using connectors and ports  Never force a connector into a port. Check for 
obstructions on the port. If the connector and port don’t join with reasonable ease, 
they probably don’t match. Make sure that the connector matches the port and that 
you have positioned the connector correctly in relation to the port.

Keeping iPod shuffle within acceptable temperatures  Operate iPod shuffle in a place 
where the temperature is always between 32º and 95º F (0º and 35º C). iPod shuffle 
play time might temporarily shorten in low-temperature conditions.

Store iPod shuffle in a place where the temperature is always between -4º and 113º F 
(-20º and 45º C). Don’t leave iPod shuffle in your car, because temperatures in parked 
cars can exceed this range.

When you’re using iPod shuffle or charging the battery, it’s normal for iPod shuffle to 
get warm. The exterior of iPod shuffle functions as a cooling surface that transfers heat 
from inside the unit to the cooler air outside.

Keeping the outside of iPod shuffle clean  To clean iPod shuffle, unplug all cables, turn 
it off (slide the three-way switch to OFF), and use a soft, slightly damp, lint-free cloth. 
Avoid getting moisture in openings. Don’t use window cleaners, household cleaners, 
aerosol sprays, solvents, alcohol, ammonia, or abrasives to clean iPod shuffle.

Disposing of iPod shuffle properly  For information about the proper disposal of 
iPod shuffle, including other important regulatory compliance information, see 
“Regulatory Compliance Information” on page 36.

NOTICE:  Failure to follow these handling instructions could result in damage to 
iPod shuffle or other property.
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8 Learning More, Service, 
and Support 

You can find more information about using iPod shuffle 
in onscreen help and on the web.

The following table describes where to get iPod-related software and service 
information.

To learn about Do this

Service and support, 
discussions, tutorials, and 
Apple software downloads

Go to:  www.apple.com/support/ipodshuffle

Using iTunes Open iTunes and choose Help > iTunes Help. 
For an online iTunes tutorial (available in some areas only), go to:   
www.apple.com/itunes/tutorials

The latest information about 
iPod shuffle

Go to:  www.apple.com/ipodshuffle

Registering iPod shuffle To register iPod shuffle, install iTunes on your computer and 
connect iPod shuffle.

Finding the iPod shuffle serial 
number

Look under the clip on iPod shuffle. Or, in iTunes (with iPod shuffle 
connected to your computer), select iPod shuffle in the list of 
devices, and click the Summary tab.

Obtaining warranty service First follow the advice in this booklet, the onscreen help, and 
online resources, and then go to:  
www.apple.com/support/ipodshuffle/service
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Regulatory Compliance Information

FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, 
and (2) this device must accept any interference 
received, including interference that may cause 
undesired operation. See instructions if interference 
to radio or television reception is suspected.

Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed 
and used properly—that is, in strict accordance with 
Apple’s instructions—it may cause interference with 
radio and television reception.

This equipment has been tested and found to 
comply with the limits for a Class B digital device in 
accordance with the specifications in Part 15 of FCC 
rules. These specifications are designed to provide 
reasonable protection against such interference in a 
residential installation. However, there is no 
guarantee that interference will not occur in a 
particular installation.

You can determine whether your computer system is 
causing interference by turning it off. If the 
interference stops, it was probably caused by the 
computer or one of the peripheral devices.

If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 

interference stops.
Â Move the computer to one side or the other of the 

television or radio.
Â Move the computer farther away from the 

television or radio.
Â Plug the computer into an outlet that is on a 

different circuit from the television or radio. (That 
is, make certain the computer and the television or 
radio are on circuits controlled by different circuit 
breakers or fuses.)

If necessary, consult an Apple-authorized service 
provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician 
for additional suggestions.

Important:  Changes or modifications to this product 
not authorized by Apple Inc. could void the EMC 
compliance and negate your authority to operate 
the product.

This product was tested for EMC compliance under 
conditions that included the use of Apple peripheral 
devices and Apple shielded cables and connectors 
between system components. 

It is important that you use Apple peripheral devices 
and shielded cables and connectors between system 
components to reduce the possibility of causing 
interference to radios, television sets, and other 
electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and 
connectors through an Apple Authorized Reseller. 
For non-Apple peripheral devices, contact the 
manufacturer or dealer for assistance. 

Responsible party (contact for FCC matters only): 
Apple Inc. Corporate Compliance
1 Infinite Loop, MS 26-A
Cupertino, CA 95014-2084

Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.

Cet appareil numérique de la classe B respecte 
toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.

VCCI Class B Statement

Korea Class B Statement
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Russia

European Community
Complies with European Directives 2006/95/EEC and 
89/336/EEC.

Disposal and Recycling Information

This symbol indicates that your product must be 
disposed of properly according to local laws and 
regulations. When your product reaches its end of 
life, contact Apple or your local authorities to learn 
about recycling options.

For information about Apple’s recycling program, 
go to:  www.apple.com/environment/recycling

Battery Replacement
The rechargeable battery in iPod shuffle should be 
replaced only by an authorized service provider. For 
battery replacement services, go to:
www.apple.com/batteries/replacements.html

Battery Disposal Information
Your iPod shuffle contains a battery. Dispose of your 
iPod shuffle according to your local environmental 
laws and guidelines.

Deutschland:  Dieses Gerät enthält Batterien. Bitte 
nicht in den Hausmüll werfen. Entsorgen Sie dieses 
Gerätes am Ende seines Lebenszyklus entsprechend 
der maßgeblichen gesetzlichen Regelungen.

China:

Nederlands:  Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) 
worden gedeponeerd.

Taiwan:

European Union—Disposal Information: 

This symbol means that according to local laws and 
regulations your product should be disposed of 
separately from household waste. When this product 
reaches its end of life, take it to a collection point 
designated by local authorities. Some collection 
points accept products for free. The separate 
collection and recycling of your product at the time 
of disposal will help conserve natural resources and 
ensure that it is recycled in a manner that protects 
human health and the environment.

Apple and the Environment 
At Apple, we recognize our responsibility to 
minimize the environmental impacts of our 
operations and products.

For more information, go to: 
www.apple.com/environment

© 2009 Apple Inc. All rights reserved. Apple, the Apple logo, iPod, 
iTunes, Mac, Macintosh, and Mac OS are trademarks of Apple Inc., 
registered in the U.S. and other countries. Finder and Shuffle are 
trademarks of Apple Inc. Apple Store and iTunes Store are service 
marks of Apple Inc., registered in the U.S. and other countries. Other 
company and product names mentioned herein may be trademarks of 
their respective companies. 

Mention of third-party products is for informational purposes only and 
constitutes neither an endorsement nor a recommendation. Apple 
assumes no responsibility with regard to the performance or use of 
these products. All understandings, agreements, or warranties, if any, 
take place directly between the vendors and the prospective users. 
Every effort has been made to ensure that the information in this 
manual is accurate. Apple is not responsible for printing or clerical 
errors.

019-1454/2009-03
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Index

A
AAC, converting songs to  19
albums, purchasing  12
announcements

playlist menu order  24
song title and artist name  23
song titles and artist names  23

Apple Earphones with Remote  5
Apple USB Power Adapter  33
artist names, announcing  23
audiobooks

hearing name  23
listening to  21
purchasing  12
syncing  17

audio file formats  29
autofilling iPod shuffle  18

B
battery

charge status  8
charging  8, 28
checking status in iTunes  8
rechargeable  9
replacement information  32
status  9
status lights when connected  9
status lights when disconnected  9

bit-rate formats  19
browsing iTunes Store  12

C
CDs, importing into iTunes  13
charging the battery

about  8, 28
using the Apple USB Power Adapter  8
using your computer  8

choosing playlists  23
compressing songs  19
computer

charging the battery  8
connecting iPod shuffle  6

problems connecting iPod shuffle  29
requirements  30

connecting iPod shuffle
about  6
charging the battery  8

controls
status light response  21
using  5

converting songs to AAC files  19
converting unprotected WMA files  30

D
data files, storing on iPod shuffle  26
deleting songs  18
disconnecting iPod shuffle

about  6
during music update  7
eject first  7
instructions  7

disk, using iPod shuffle as  26
downloading podcasts  12

E
earphone remote  5, 21, 23, 24
Eject button in iTunes  7
ejecting iPod shuffle before disconnecting  7
enabling VoiceOver feature  22
entering song information manually  13
exiting the playlist menu  24
external disk, using iPod shuffle as  26

F
fast-forwarding  6
features of iPod shuffle  3
fitting more songs onto iPod shuffle  19
formats, audio file  29

G
Genius

button in iTunes  15
creating a playlist in iTunes  15

getting help  35
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H
headphones. See earphones
hearing damage, avoiding  33
help, getting  35
higher bit rate songs  19
high-power USB port  6, 8, 28, 29, 30

I
importing CDs into iTunes  13
iTunes

ejecting iPod shuffle  7
getting help  35
importing CDs  13
iTunes Store  12
setting not to open automatically  27
version required  30

iTunes Library, adding songs  13
iTunes Store

browsing  12
downloading podcasts  12
purchasing audiobooks  12
purchasing songs and albums  12
searching  12
signing in  11

L
library, adding songs  13
listening to an audiobook  21

M
Mac OS X version  30
manually managing music  17
maximum volume limit, setting  25
music

iPod shuffle not playing  29
purchasing  12
tutorial  35
See also songs; syncing music

N
names

spoken song titles  23
navigating by song title  23
next track  6

O
operating system requirements  30
overview of iPod shuffle features  3

P
pausing a song  6
playing

previous song  6
songs  6
songs in order  5

play in order  5, 21
playlist menu

choosing an item  24
exiting  24
order of announcements  24

playlists
choosing from spoken menu  23
Genius  15
hearing spoken menu of  23
restarting  24
See also playlist menu

podcasts
browsing for  12
downloading  12
hearing name  23
listening to  21
syncing  17

ports
earphone  4, 5
high-power USB  6, 8, 28, 29, 30
troubleshooting iPod shuffle connection  29
USB 2.0  28, 29, 30

power adapter, USB  8
Power Search in iTunes Store  12
power switch  4
preventing iTunes from opening automatically  27
previous track  6
problems. See troubleshooting
purchasing songs, albums, audiobooks  12

R
random play  5
rechargeable batteries  9
registering iPod shuffle  35
relative volume, playing songs at  24
remote, earphone. See earphone remote
removing songs  18
requirements

computer  30
iTunes version  30
operating system  30

resetting iPod shuffle  5, 28
reshuffling songs  22
restart current track  6, 21
restarting a playlist  24
restoring iPod software  31
rewinding  6

S
Safely Remove Hardware icon  7
safety considerations  32
searching iTunes Store  12
serial number, locating  5, 35
service and support  35
setting play order of songs  5
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settings
autofill  19
manually manage music  17
playing songs at relative volume  24
shuffle songs  21
speech options  22
volume limit  25

shuffling songs  5, 21
skipping to next track  6
sleep mode and charging the battery  8
software, updating and restoring  31
songs

autofilling  18
deleting  18
entering information manually  13
fast-forwarding  6
hearing title of currently playing song  23
playing and pausing  6
playing at relative volume  24
playing in order  5
playing next or previous  6
purchasing  12
removing  18
reshuffling  22
rewinding  6
shuffling  5, 21
skipping to the next  6
syncing manually  17

song titles
announcing  23
navigating by  23

Sound Check, enabling  24
speech options  22
status light

battery  8, 9
location  4
response to controls  21

storing, data files on iPod shuffle  26
subscribing to podcasts  12
supported audio file formats  29
supported operating systems  30
switch, three-way  4
syncing audiobooks  17
syncing music

disconnecting iPod shuffle  7
overview  15

tutorial  35
syncing podcasts  17
syncing songs manually  17
system requirements  30

T
three-way switch  4
tracks. See songs
troubleshooting

connecting iPod shuffle to computer  29
connecting to USB port  29
cross-platform use  31
iPod shuffle not playing music  29
iPod shuffle not responding  28
resetting iPod shuffle  5, 28
safety considerations  32
updating and restoring software  31

turning iPod shuffle on or off  5
tutorial  35

U
unresponsive iPod shuffle  28
unsupported audio file formats  30
updating and restoring software  31
USB 2.0 port  28, 29
USB Power Adapter  8

V
VoiceOver

battery status  9
disabling  23
enabling  22
song announcements  23
using  22

volume
changing  6
enabling Sound Check  24
setting limit  25

W
warranty service  35
Windows

supported versions  30
troubleshooting  31

WMA files, converting  30
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